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1 About this document
This document is about the features and functionality of Trading Terminal through
which a user can place orders and view current market statistics in real time. It intends
to guide the user of the application about all views and windows available so that
he/she can use it effectively. The document discusses different types of views available
in the application as well as different customisation options to customize these views
according to user preferences.

1.1 Document Composition
The document contains different sections that explain different menu groups of the
application. Starting from File menu, it explains View, Order, Trading, Graph, Account
Status, Reports and Setting menu options. Different customisation options available for
views are also explained.
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2 Introduction
Trading Terminal is an online trading application that offers the ability to buy and sell
shares and view real time stock information. On start up, Trading Terminal gets
connected with the Trading Server that is connected with the trading engine and
facilitates communication between Trading Terminal and trading engine. Terminal offers
a variety of different useful menu options that facilitate sale/purchase of shares and
manage client information efficiently.
Trading Terminal provides following advanced features:
Current market statistics for different stocks and exchange statistics are provided
through a number of views e.g. Market Watch, Waterfall Ticker, Exchange Watch and
Time of Sale etc.
Outstanding Orders and Transaction List views are maintained which keep record of all
pending orders and executed trades respectively. A file is also maintained keeping
record of all of the current day trades.
Buy/Sell orders can be placed and users can also cancel their pending orders. Client
margin is checked in real time during order entry, taking into account the client’s
executed trades and pending orders.
Client can view his/her current clearing portfolio and different reports are also provided
to show custody positions and day trades.
All of the views can be customized according to user preferences and the customisations
persist even after exiting from the application and are restored on start up.
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3 GETTING STARTED
By default, Trading Terminal is installed in Start Menu -> Programs -> BackConnect ->
Trading Terminal folder of start menu. So Trading Terminal can be started by clicking
Start Menu -> Programs ->BackConnect -> Trading Terminal -> Trading Terminal.
Configuration option in the same menu contains some configuration parameters that
are appropriate when application is installed but can be modified later if required.

3.1 Login
3.1.1 Login Window
Each application user is provided with a unique user name and password. Each user has
a particular user type that determines the level of access the user has to the application.
There are different types of users.

Client user has full access to all of the views and screens.

Subscriber user has limited access to the application. Order related views and
functionality is not available for this type of user while all other market statistic views
are available.

For application login,
Enter user ID in the User Id field.
Enter password in the Password field.
Press the ENTER key or click OK button.

Figure 1: Login Window
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Clicking Cancel button asks to exit from the application and will exit on selecting Yes.

3.1.2 Server not Connected
First of all, Terminal tries to connect with the Trading Server. In case, it fails to connect
with the Server, following message appears. The connection may fail due to having
temporary Server shutdown or some communication link failure. On successful
connection with the server, User Id and password is verified.

Figure 2: Connection Failed

3.1.3 Invalid User Id / Password
In case of invalid User Id or password, following message appears stating that either
user id or password is incorrect.

Figure 3: Login Failed

3.1.4 User Not Configured
In case when a user is not allowed to use Trading Terminal application, following
message appears stating that the user has not been configured to use the application.
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Figure 4: Invalid User

3.2 Application Startup
After successful login, following screen appears.

Figure 5: Main Application Window
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3.3 File Menu
3.3.1 Trade Log

(Ctrl + D)

During the market sessions, executed trades of the user are saved in a file that can be
viewed by using Trade Log option. After opening the trade log file, these trades can be
printed. A new file is generated daily and maintained for all of the day trades.

Figure 6: Trade Log File

3.3.2 Messages

(Ctrl + G)

During each application session, Message Board (see section 3.4.5) shows different
types of messages intended for the user. The messages might include login
confirmations, order entry confirmations, executed trade confirmations, password
change confirmations etc. In addition to showing these messages on Message Board,
these are also saved in a messages file. The file contains messages for current session
only and can be viewed by using Messages option in the file menu. After opening the
Messages file, these messages can also be printed.
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Figure 7: Messages File

3.3.3 Exit

(Ctrl + X)

User can exit from the application by selecting exit option. Before exit, it saves current
application settings for different views and these settings are restored next time the
application is started.
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3.4 View Menu
Most of the views are exchange feed based and have similar customisation options.
User can choose symbols to be shown in the view. User can select different columns to
be shown on the view from a list of columns and can also arrange these columns in
some desired order. Different colors for view background, foreground etc., fonts and
font sizes are also customisable. User’s current settings for different view attributes,
layout and positioning are saved on application exit and persist even after application
has been closed. These settings are restored next time application is started.

3.4.1 Market Watch

(Ctrl + M)

Market Watch shows current buy and sell market positions for each symbol. Each row
shows current market statistics for a particular symbol in a particular market. Different
customisation options can be selected from the popup menu that appears on right
clicking the view.

Figure 8: Market Watch
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3.4.2 Waterfall Ticker

(Ctrl + T)

Waterfall Ticker also shows current buy/sell market positions and trades for selected
symbols but it presents these positions in a different format than Market Watch. Here
each new record is shown in a new row with a different color than the earlier record
and overwrites the already written records. Different customisation options can be
selected from the popup menu that appears on right clicking the view.

Figure 9: Waterfall Ticker
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3.4.3 Time of Sale

(Ctrl + S)

Time of Sale is useful to observe closely the changing market situation for a stock. It is
similar to waterfall ticker in its representation. The difference is that it is displaying
trades of the selected scrip along with the time stamp of the trade.

Figure 10: Time of Sale
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3.4.4 Exchange Watch

(Ctrl + E)

This view displays different stock exchange statistics and contains only a single row.
Different columns in the row are updated with the change in corresponding column’s
value. Different customisation options can be selected from the popup menu that
appears on right clicking the view.

Figure 11: Exchange Watch
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3.4.5 Message Board
Message Board provides an interface through which user is kept aware of different
events happening in the system. Whenever a user places some order or
modifies/cancels an existing order, Message Board shows different messages regarding
the status of these orders. Similarly when an order gets executed, a trade confirmation
appears on the Message Board. Moreover different types of messages are shown in
different colors so that they can be identified easily. These messages are also saved in a
messages file that can be viewed by using Messages option in File menu (see section
3.3.2). Message Board is made visible automatically at the start of the application.
Afterwards, if it is closed, it reopens whenever a new message arrives or can be opened
from Message Board option in View menu.

Figure 12: Message Board
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3.4.6 Price Alert
Price Alert provides alarming notifications to the user whenever the price of certain
symbols crosses certain upper and lower limits. These upper and lower limit values can
de defined by the user through Price Alerts setting option (see section 3.10.2). Price
Alert does not appear in menu and is displayed automatically as soon as any symbol
price crosses limits defined by the user and never appears if no such limits have been
defined. Price Alert appears on top of all other views and in upper left corner of the
application main window.

Figure 13: Price Alert
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3.5

Order Menu
A user can place purchase / sale orders through order entry windows and can also
modify and cancel already placed orders which have not been traded yet. Order
windows also show current market position for the selected market and symbol. Order
windows are like user input screens and do not have any customisation options
available, although position of the order window is saved on exiting the application and
restored next time.

3.5.1 Buy Order

(F4)

User can place buy orders through this window, which also shows the best market and
last trade price etc. for the selected market and symbol.

Figure 14: Buy Order
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3.5.2 Sell Order

(F5)

User can place sell orders through this window, which also shows the best market and
last trade price etc. for the selected market and symbol.

Figure 15: Sell Order
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3.5.3 Modify Order

(F9)

Order modification can be carried out by selecting the order (to be modified) from
Outstanding orders view (see section 3.5.5) by left clicking the order and then selecting
the Modify Order option from the popup menu that appears on right clicking the
selected order. On clicking the Modify Order option in the popup menu, selected order
is opened automatically in the Modify Order window where it can be modified and sent
to the Trading Server.
Alternatively, Modify Order window can be opened from the Orders menu to modify the
order. Order number (for the order to be modified) is entered in the Order Number field
and enter key is pressed. On pressing enter, modify order window is populated with the
order that can now be modified.
Only Volume, Price and Trigger Price entries for the order can be modified and hence
are editable. All other fields appear as read only in the Modify Order window. The order
will be modified only if it has not been traded yet. After successful modification, order is
updated in the outstanding orders view.

Figure 16: Order Selection for Modification
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Figure 17: Modify Order
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3.5.4 Cancel Order

(F11)

Order cancellation can be carried out by selecting the order (to be cancelled) from
Outstanding orders view (see section 3.5.5) by left clicking the order and then selecting
the Cancel Order option from the popup menu that appears on right clicking the
selected order. On clicking the Cancel Order option in the popup menu, the selected
order is opened automatically in the Cancel Order window where it can be cancelled.
Alternatively, Cancel Order window can be opened from the Orders menu to cancel the
order. Order number (for the order to be cancelled) is entered in the Order Number
field and enter key is pressed. On pressing enter, cancel order window is populated with
the order that can now be cancelled.
All of the order fields appear as read only in the Cancel Order window. The order will be
cancelled only if it has not been traded yet. After successful cancellation, order
disappears from the outstanding orders view.

Figure 28: Order Selection for Cancellation
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Figure 39: Cancel Order
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3.5.5 Outstanding Orders (Ctrl + O)
This view keeps record of all of the orders of the user that are still outstanding and have
not been traded yet. Whenever a new order is placed, it appears in the outstanding
orders view and remains there as long as it is not traded. Buy and Sell orders appear in
different colors in the view and from here they can be selected for modification or
cancellation. When an order is cancelled or it gets traded fully, it disappears from the
outstanding orders view. When an order is modified or gets traded partially, it is
updated in the outstanding orders view. Different customisation options can be selected
from the popup menu that appears on right clicking the view.

Figure 20: Outstanding Orders
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3.5.6 Outstanding Orders Summary

(Ctrl + U)

This view shows a summary of all outstanding orders of the user that have not been
traded yet. All outstanding orders are shown in order of symbol and side (buy/sell) and
at the end of each symbol a summary shows the total buy and sell volume and amount
of outstanding orders in that particular symbol. This summary can be viewed for a
particular symbol or for all symbols (if no symbol is specified). Different customisation
options can be selected from the popup menu that appears on right clicking the view.

Figure 21: Outstanding Orders Summary
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3.6 Trading Menu
Trading Menu contains transaction views that show the currently executed trades of the
user. Details and summary of these trades are shown in separate views. Delivery
request screen facilitates the client to request share delivery of his/her purchases.

3.6.1 Transaction List

(Ctrl + R)

Transaction List keeps record of all of the current day executed trades. On application
start up, the view loads executed trades of the user for current day (if any). Later,
whenever user’s order gets traded, the view is updated to show a new entry for the
trade. Buy and Sell trades appear in different color in the view and a trade log file is also
generated which maintains a log of all of these trades and can be viewed from File menu
(see section 3.3.1). Different customisation options can be selected from the popup
menu that appears on right clicking the view.

Figure 22: Transaction List
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3.6.2 Transaction Summary

(Ctrl + Y)

Transaction Summary shows a summary of all of the current day executed trades. All
executed trades are shown in order of symbol and side (buy/sell) and at the end of each
symbol a summary shows the total buy and sell traded volume and average price of
these trades in that particular symbol. This summary can be viewed for a particular
symbol or for all symbols (if no symbol is specified). Different customisation options can
be selected from the popup menu that appears on right clicking the view.

Figure 23: Transaction Summary
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3.6.3 Delivery Request

(Ctrl + Q)

Delivery Request screen facilitates the user to request share delivery of current day
purchases. The user will request share delivery typically after closing the regular market
and before the start of COT market although it can also be requested during the regular
market. By default the purchases are included for current day COT in the COT market
unless user makes a delivery request of shares, in that case those are not included for
COT. On opening the delivery request screen, user’s current day purchases are shown
along with the volumes in each symbol and user can edit the delivery column to enter
the delivery volume. Initially delivery volume is set to zero and COT volume is set to the
total purchase volume. On editing the delivery volume, COT volume is adjusted
accordingly for that symbol. On submitting the request, delivery requests are updated.
Later on if user wants to clear all of the delivery requests he/she can use the Clear
button to clear all delivery requests. User can refresh the screen by using the Refresh
option from popup menu that appears on right clicking the screen. Different
customisation options can also be selected from the popup menu.

Figure 24: Delivery Request
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3.7 Graph Menu
Trading Terminal provides an advanced and highly flexible charting module. Real time
charting is available for exchange statistics and trades in a symbol. The components
have the flexibility to be scaled according to user’s requirements.

3.7.1 Stock Graph

(Ctrl + K)

Stock Graph plots trade rates of a symbol (in a particular market) against time. User can
enter the symbol and can select a particular market. On pressing ok button, the chart
gets history data for the symbol on that day, plots it and after that starts plotting trades
coming in real-time. So at any time, it shows complete history of the symbol on current
day. Stock Graph also provides flexible scaling options.

Figure 25: Stock Graph
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3.7.2 Index Graph

(Ctrl + I)

Index Graph plots stock exchange index value against time. On pressing ok button, the
chart gets history data for the day, plots it and after that starts plotting the index in realtime. So at any time, graph shows the complete history of the exchange index on
current day. Index Graph also provides flexible scaling options.

Figure 26: Index Graph
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3.8 Account Status Menu
Current Portfolio provides a comprehensive view of client’s holdings in current clearings.
View is also facilitated with different customisation options like all other views.

3.8.1 Current Portfolio

(Ctrl + F)

Current Portfolio contains clearing type option through which user can select required
clearing type. On selecting a particular clearing type, view shows client’s outstanding
positions for the selected clearing type. It gives a fair evaluation of the client’s holdings
with respect to the current market rate. It also shows some other statistics such as
average cost, market value and un-realized gain/loss etc. Different customisation
options can be selected from the popup menu that appears on right clicking the view.

Figure 27: Current Portfolio
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3.9 Reports Menu
Trading Terminal provides a number of reports related to client’s account ledger,
custody position and day trades. All of the reports can be viewed using Fetch button
while these reports can be printed using print button provided in each report view.

3.9.1 Client Account Ledger
Client Account Ledger provides client’s cash activity as on a particular date as the report
can be requested for any trade date. Opening balance shows the client’s net cash
position at the start of that date and then there is detail of all cash activities on that
date.

Figure 28: Client Account Ledger
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3.9.2 Net Custody Position
Net Custody Position provides a detail of client’s net custody position for each symbol as
on a particular date. The report can be requested for a particular date or for a particular
symbol while custody position in all symbols is shown if symbol is not specified. The
report shows the custody position in physical tradable and CDC tradable stocks and also
shows a net custody position in each of regular, spot and forward clearing types for
requested symbol(s).

Figure 29: Net Custody Position
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3.9.3 Daily Trade Confirmation
Daily Trade Confirmation shows symbol wise detail of client’s trades in a specific period
of time. Report can be requested for a specific period of time, for a particular symbol
and also for a particular clearing type.

Figure 30: Daily Trade Confirmation
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3.9.4 Periodic Trade Summary
Periodic Trade Summary shows symbol wise summary of client’s trades in a particular
period of time. Report can be requested for a particular period of time and for a
particular clearing type. It shows the summary of client’s trades in all symbols.

Figure 31: Periodic Trade Summary
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3.10 Setting Menu
Setting Menu provides some other useful options like change password, price alert
settings and company symbols listing.

3.10.1 Change Password

(Ctrl + G)

This option is used if user wants to change his/her password. Password can be changed
at any time while using the application and after successful change new password
becomes effective immediately.
To change password,
Enter old password in the Old Password field.
Enter new password in the New Password field.
Retype new password in the Confirm Password field.
Press the ENTER key or click OK button.
New Password and Confirm Password fields are matched and old password is also
verified. New password becomes effective immediately if password has been changed
successfully otherwise appropriate error messages is returned.

Figure 32: Change Password
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3.10.2 Price Alerts

(Ctrl + P)

Trading Terminal provides price alerts on prices of different symbols. Whenever the
price of a certain symbol crosses the upper or lower limit, price alert (see section 3.4.6)
is displayed on top of all other views showing the trade price for the symbol. Price Alerts
dialog can be used to specify the upper and lower limit on prices of symbols crossing
which user requires the price alert to appear. Here the user selects a particular market,
enters the symbol for which he/she requires the price alert and lower and upper limits
crossing which alert view should appear.

Figure 33: Price Alert Settings
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3.10.3 Symbol Listing(Ctrl + B)
Symbol Listing provides the list of all valid symbols used and recognized by the
application along with full company names. This view can be used to verify and/or find
out the symbol for a company name. This view can also be invoked directly from the
symbol list customisation dialog (see section 3.11.1) available for different views to
select symbols.

Figure 34: Symbol Listing
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3.11 Customizing the application
Similar types of customisation options are available for almost all of the views. These
customisations are applied to the view immediately after closing the customisation
dialog. Moreover the customisation settings are saved on application exit and are
reloaded when application is started next time. These customisation dialogs can be
made to appear by selecting corresponding option from the popup menu appearing on
right clicking the view to which these settings are to be applied.

3.11.1 Symbol Selection
Symbol List provides a dialog to enter symbols for which market and trade positions are
shown in Market and Ticker views. User can set his/her own list of symbols for these
views by using Symbol List option. Each entry in this list consists of a market and symbol.
Duplicate entries are not allowed. User can also select symbols from the Symbol Listing
dialog that appears on clicking the button present on right side of the symbol field,
instead of entering the symbol.

Figure 35: Symbol Selection
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3.11.2 Column Selection
Column Options dialog allows users to select a list of columns that will appear on a
particular view. User can also arrange these columns in a desired order and they will
appear on the view in the same order as selected by the user.

Figure 36: Column Selection
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3.11.3 Color Selection
Views provide flexible color setting options. So user can select specific colors for view
background, view foreground, view header background, view header foreground, view
grid lines etc. and these color settings are applied to the view immediately after closing
the color dialog. Default option reverts the current color settings to default settings.

Figure 37: Color Selection
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3.11.4 Font Selection
Views also provide flexible font settings that can be changed through Font dialog. Here
user can select a particular font, font size and different font attributes and these
settings are applied to the whole text appearing in the main window of the view.

Figure 38: Font Selection
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